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1
About Dell License Manager
Dell License Manager is a one-to-many license deployment and reporting tool for integrated Dell 
Remote Access Controller (iDRAC) and Dell chassis management controller (CMC) licenses.

Dell License Manager can deploy and backup:

• iDRAC licenses on all Dell’s 12th and 13th generation of PowerEdge servers (denoted as yx2x and 
yx3x) that are equipped with an iDRAC7 or iDRAC8 Dell Remote Access controller.

NOTE: For the server name format yxxx; y denotes alphabets, for example, M (modular), R (rack), 
or T (tower) and x denotes numbers. For example, a PowerEdge R720 is a 12th Generation rack 
mount 700 series server.

• CMC licenses on Dell PowerEdge VRTX and PowerEdge FX or FX2s chassis.

• OpenManage Essentials perpetual licenses.

• PowerEdge storage sled licenses.

Dell License Manager can also inventory licensable systems to report the licensing status and currently 
enabled management controller feature level.

Use Dell iDRAC licenses to enable server management capabilities such as the virtual media and remote 
console support currently available in the Enterprise iDRAC feature set.

Use Dell CMC licenses to enable chassis management capabilities such as console integration, remote 
access, mutli-chassis management, server cloning, and so on.

You can download licenses from the Dell Online Licensing Portal at dell.com/support/retail/lkm. You 
can purchase licenses when you purchase a server or a chassis.

 

What is New in This Release

Support for the Dell PowerEdge storage sled.

5



2
Installing Dell License Manager

Minimum System Requirements

Particulars Requirement

Hard Disk 200 MB (minimum)

RAM 2 GB (minimum)

Operating Systems Microsoft Windows 7

Microsoft Windows Server 2008 R2

Windows Server 2008 (SP2 or later)

Windows Server 2012

Windows Server 2012 R2

Both 64-bit and 32-bit versions are supported.

Network 100 Mbps or higher

Screen Resolution 1024 X 768

Microsoft .NET 4.5

Remote Management Windows Remote Management (WinRM) 2.0

This functionality is included in Windows 7 and 
Windows Server 2008 R2.

The WinRM prerequisite is available through 
Microsoft Windows Update.

Limitations

Dell License Manager supports up to 3500 licensable systems and an inventory of up to a class B IP 
address range (65,536 addresses).
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Installing Dell License Manager
1. Download Dell License Manager from dell.com/support.

2. Double-click the License Manager Windows installer package.

3. Select a language for the installation, and click OK.

4. In the Welcome screen, click Next.

5. In License Agreement, select I accept the terms in the license agreement and click Next.

6. In Setup Type, do any of the following:

• To accept the default installation path, choose the Typical installation, and click Next.

• To enable specific program features and change the installation path, select the Custom 
installation option and click Next. In Custom Setup, select the License Manager features that you 
require; check for disk space and assign a new location for installing Dell License Manager.

7. In the Ready to Install the Program screen, click Install.

The InstallShield Wizard Completed page is displayed.

8. If you want to launch License Manager, select Launch Dell License Manager, and then click Finish.
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3
Getting Started With Dell License 
Manager
You can access Dell License Manager from the Windows desktop in one of the following ways:

• Windows 8, Windows Server 2012, or later operating systems — Move the mouse pointer to the 
bottom-left corner, and then click the Start icon. On the Start screen, click the License Manager tile.

• Windows 7, Windows Server 2008, or earlier operating systems — Click Start→ All Programs→ Dell 
OpenManage Applications→ License Manager→ License Manager.

• Double-click the License Manager icon.

NOTE: Local administrator privileges are required to run Dell License Manager.

The Getting Started with Dell License Manager screen is displayed with information on getting started 
with license deployment.
 

Dell License Manager User Interface

The Dell License Manager contains a menu bar, task status bar, navigation pane, and an active view pane.

Figure 1. Dell License Manager Interface

1. Menu bar
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2. Task status bar

3. Navigation pane

4. Active view pane

Menu Bar

The menu bar consists of the Actions, View, and Help menus.

Actions Menu

The Actions menu consists of:

• Discover and Inventory Systems — Launches the Discovery/Inventory Wizard. See Inventorying 
Licensable Systems.

• Launch Dell Online License Portal — Select this option to access the Dell Online Licensing Portal at 
dell.com/support/retail/lkm. Before you access the portal, make sure that your system has Internet 
connectivity. From the online portal you can download Dell licenses.

• Import Licenses — Launches the Import Wizard. See Importing Licenses.

• Automatically Deploy Licenses — Selects all undeployed licenses bound to systems in inventory for 
deployment and launch the License Management Wizard. See Deploying Licenses.

• Export License Archive — Saves an archive containing all licenses in inventory in the compressed file 
format. See Managing Licenses.

• Save Report — Saves a CSV, HTML, or XML informational report from system, license, or log view. See 
the section on the respective view for more information.

• Clear Log — Removes all entries from the activity log.

NOTE: This option does not remove information on tasks from task view. See Managing Tasks 
and Logs.

• Exit — Closes the Dell License Manager application. This option ends all current tasks.

View Menu

The View menu consists of:

• Systems — Navigates to the Systems view.

• Licenses — Navigates to the Licenses view.

• Tasks — Navigates to the Tasks view.

• Logs — Navigates to the Logs view.

• Getting Started — Displays the Getting Started with Dell License Manager screen.

Help Menu

The Help menu consists of:

• Dell License Manager Help — To access the Dell License Manager help. You can also access the Dell 
License Manager help by clicking the help icon within each view.

• Online Support — To access the Dell Technical Support at dell.com/support.

• Generate Support Log Archive — To generate an archive of activity logs which Dell Technical Support 
can use to troubleshoot problems.

• About — To view the Dell License Manager version and copyright information.
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Task Status Bar

The Task Status bar shows the number of running and completed tasks. Clicking the Task Status bar 
activates the Task view.

Help Icon

Click the help icon  to access context-sensitive online help.

Dell License Manager Views

Dell License Manager supports the following primary views:

• Systems view

• Licenses view

• Tasks view

• Logs view

Systems View 

The Systems view is accessible through the Systems link in the navigation pane. From the Systems View, 
you can:

• Discover and inventory licensable systems

• Deploy licenses

• View system licensing status

• Remove licenses from systems

For more information on systems view, see Working With Licensable Systems.

Licenses View

The Licenses view is accessible through the Licenses link in the navigation pane. From the Licenses View, 
you can:

• Import downloaded licenses into Dell License Manager

• View information on available licenses

• Deploy licenses

• Export a license archive

For more information on licenses view, see Managing Licenses.

Tasks View 

The Tasks view is accessible through the Tasks link in the navigation pane. From the Tasks View, you can:
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• View archived task results

• Save reports

• Generate support log archives

For more information on tasks view, see Managing Tasks and Logs.

Logs View 

The Logs view is accessible through the Logs link in the navigation pane. From the Logs View, you can:

• View archived task results

• Save reports

• Generate support log archives

For more information on logs view, see Managing Tasks and Logs.

Working With Views 

The systems, licenses, tasks, and logs data view grids allow sorting, grouping, and filtering. You may also 
choose which columns to display in the data grid.

• Sorting — To sort on a particular column, click the column header. Clicking the header again sorts the 
column in reverse order.

• Grouping — To group items together, select the column on which to group from the Group By menu 
in the grid header.

• Filtering — To filter data rows, select the column on which to filter and click the filter icon. Select the 
filter operation and then enter the filter string. To clear the filter, select the filter icon and click Clear 
Filter.

• Selecting Columns — To select which columns are displayed, click the Show/Hide Columns icon. 
Selected columns are displayed.

Understanding Licenses

Dell Licenses contain the following properties:

• Entitlement Identifiers — Each license has an Entitlement ID, which uniquely identifies that license.

• License Descriptions — The description specifies the level of features enabled in the license. For more 
information, see License Descriptions.

License Descriptions

The license description specifies the level of features enabled in the license. For more information on the 
iDRAC functionality supported by each feature level, access the online licensing portal at dell.com/
support/retail/lkm. The following licenses are available:

• Perpetual licenses

• Evaluation licenses

• Bound licenses

• Upgrade licenses
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Perpetual Licenses

Perpetual licenses are standard licenses that enable iDRAC features and do not expire.

Evaluation Licenses 

Evaluation licenses allow a 30-day trial of specific iDRAC features, with an available 30-day extension.

NOTE: You cannot deploy or archive evaluation licenses in Dell License Manager.

Bound Licenses

Dell Perpetual licenses are bound to a particular system Service Tag and you can deploy the licenses only 
on those systems.

Upgrade Licenses 

Some Dell Licenses are upgradeable. An upgrade license includes an Upgrade ID referencing the 
Entitlement ID of the upgraded license.

License Features 

Each license includes a specific set of iDRAC features, that are enabled by the license. The license 
description summarizes the level of features included in the license.

Filtering Data
The Dell License Manager allows you to filter data in the Systems, Licenses, Tasks, and Logs views. To 
filter data:

1. Place the mouse pointer over the column heading and click the funnel icon .

2. After selecting a filter option from the drop-down list, enter the alphanumeric characters in the field 
and click the aA button to make the filter search case-independent.

3. After you set the filter logic, click Filter to run the filter logic.

NOTE: Click Clear Filter to clear a search.

Filter Options

Filter Option Description

Is equal to To create the same as logic.

Is not equal to To create the different from logic.

Starts with To filter search based on the initial alphanumeric character in a text chunk. Provide 
the starting alphanumeric character in the field.

Ends with To filter search based on the final alphanumeric character in a text chunk. Provide the 
ending alphanumeric character in the field.
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Filter Option Description

Contains To filter search based on alphanumeric characters present in a text chunk. Provide 
the alphanumeric character in the field.

Does not 
contain

To include the not present logic in search based on alphanumeric characters present 
in a text chunk.

Is contained in To include the is present logic in an alphanumeric character string.

Is not contained 
in

To include the not present logic in an alphanumeric character string.
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4
Working With Licensable Systems

Inventorying Licensable Systems
Performing discovery and inventory of licensable systems enables you to view the licensing status for 
those systems. Perform a system’s inventory before deploying licenses for the system. The inventory 
process automatically retrieves the installed non-evaluation licenses for archival purposes.
To inventory systems:

1. In Dell License Manager, click Systems.

2. In Systems, click Run Discovery and Inventory.

3. In the Select IP Address page of Discovery / Inventory Wizard, click Add Range or IP.

4. In Edit Inventory Range window, provide a name for the IP range or address, and perform one of the 
following:

• To use an IPv4 range for inventorying systems, provide the start address, end address, and subnet 
mask.

• To use an individual IP address for inventorying systems, select Individual Address (IPv4, IPv6, or 
hostname), and provide the IP address or host name.

• To use a text file for inventorying systems, select Text file with IP addresses, click Load, navigate 
and select the text file.

NOTE: You must select a text file that includes an IP address or host name on each line.

NOTE: To inventory the PowerEdge storage sleds, provide the IP address of only the chassis. 
License Manager automatically inventories the PowerEdge storage sleds while inventorying 
the chassis.

NOTE: For PowerEdge storage sleds, License Manager displays the license level of the host 
CMC as the current license.

5. Click OK.

The IP address or range that you provided is added to the IP Addresses and Ranges table.

If you selected a text file, the IP addresses and host names in the text file are verified, and the invalid 
IP addresses or host names are displayed in the Validation Report.

NOTE: 

• After the IP addresses are added from a text file, they are displayed as individual IP 
addresses.

• If there are duplicate IP addresses in the text file or if the IP addresses already exist in the IP 
Addresses and Range table, they are ignored.

• The text file cannot be edited using License Manager.

6. In the Select IP Address page of Discovery / Inventory Wizard, click Next.

7. In the IP Scan Settings page of Discovery / Inventory Wizard, provide the user credentials and 
configure the Internet Control Message Protocol (ICMP) and WS-Man options, and then click Next.

NOTE: For information on certificate settings, see Communication Settings.
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8. In the Confirm Settings page of the Discovery / Inventory Wizard:

• Review the discovery settings you provided. Click Back to edit settings.

• If you do not want to view the inventory task progress in the task pane, deselect the Show task 
pane after launch option.

9. Click Run Discovery / Inventory.

The Tasks view is displayed. You can go to the Systems view to see the inventoried systems.

NOTE: If you deselected the Show task pane after launch option in step 8, the Systems view is 
displayed.

Editing an Inventory Range
Specify the management controller IP addresses in the appropriate discovery/inventory tables. Dell 
License Manager cannot inventory license information from installed server operating systems or 
hypervisors.
To edit a range:

NOTE: To remove a range from Dell License Manager, select the entry in the table and click 
Remove Selected.

1. Click Run Discovery and Inventory.

2. Select the entry in the table and click Edit.

The Edit Inventory Range window is displayed.

3. Edit the IP Range or Address Name, IPv4 Range, or Individual Address (IPv4, IPv6, or hostname) 
based on your preference.

4. Click OK to save the changes.

Viewing Inventoried Systems
To view inventoried systems, select Systems. Inventoried systems are listed in the Systems view. The 
System Inventory table provides a summary of the inventoried systems and the System Details pane 
provides additional information on a selected system.

NOTE: For PowerEdge storage sleds, License Manager displays the license level of the host CMC as 
the current license.

Removing System Information
1. In Systems, select the systems you want to remove and click Delete.

2. When prompted, click Yes to confirm.

Saving Reports
You can save system information into reports in the CSV, XML, or HTML formats.
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To save reports:

1. From Systems, click Save Report.

2. Specify the folder location and file name, and in Save as type, select the report format, and then click 
Save.

3. In Report Saved Successfully, click OK.
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5
Managing Licenses
Using Dell License Manager you can deploy licenses to licensable systems. Dell License Manager also 
supports the export of license archives for backup. From Licenses view, you can view the status of 
available licenses.
Before you deploy licenses:

1. Inventory the licensable systems. See Inventorying Licensable Systems.

2. Obtain licenses from the Dell Online Licensing Portal.

3. Import licenses into Dell License Manager.

4. Deploy the licenses.

NOTE: To work with licenses, from the Dell License Manager, in the navigation pane, click 
Licenses.

 

Obtaining Licenses

You can download licenses from the Dell Online Licensing Portal at dell.com/support/retail/lkm. You 
can purchase licenses when you purchase a server or chassis. The licenses are installed from the factory. 
The downloaded license package contains a license archive in a compressed file format (ZIP format). The 
license archive contains license files in an XML format.

Importing Licenses
Before you import licenses, you must download licenses. You can also import archived licenses. 
However, you cannot import expired or evaluation licenses.

1. In Dell License Manager, click Actions → Launch Dell Online Licensing Portal. 

2. From the Dell licensing portal, download the required licenses to a file system.

3. From Licenses, select Import Licenses.

4. In Select Licenses, browse to the location where the license files are downloaded, select the license 
package, and then click Open.

NOTE: If a system has a license with the same Entitlement ID, then the duplicate license is 
flagged for potential licensing problems.

5. In Import Licenses:

a. If you want to filter the list of validated licenses based on the matching inventoried systems, 
select Import only those licenses which match inventoried systems.

b. Select valid licenses.

17



c. Click Import.

Deploying Licenses
Dell License Manager can automatically deploy all available licenses to discovered systems. Alternatively, 
you can select specific licenses or systems for deployment. Before you deploy licenses:

• Inventory systems on which you want to deploy licenses.

• Confirm that the inventoried systems are licensable.

• Confirm that the licenses are downloaded from Dell Online Licensing Portal.

• Confirm that the required licenses are imported into Dell License Manager.

NOTE: If numerous systems have licenses with the same Entitlement ID, then the duplicate licenses 
are flagged for potential licensing problems.

To automatically deploy licenses:

1. Select Licenses → Deploy Licenses → Automatically Deploy Licenses.

2. In operation selection page, click Next.

3. In communication settings, provide the management controller credentials, verify communication 
settings, and then click Next.

NOTE: If no matching system is found for a license, the following message is displayed: No 
matching licenses are available.

NOTE: You can monitor the deployment in task view. As systems are updated, corresponding 
information in systems view and license view are updated.

Selecting Licenses For Deployment
1. Click Licenses → Deploy Licenses → Deploy Selected Licenses.

2. In the operation selection page, verify licenses you want to deploy and click Next.

3. In communication settings, provide the management controller credentials, verify communication 
settings, and then click Next.

NOTE: You can monitor the deployment in task view. As systems are updated, corresponding 
information in system view and license view are updated.

Selecting Systems For License Deployment
1. In Systems, select the systems on which you want to deploy licenses.

2. Click Deploy Associated Licenses.

3. Select the licenses to deploy on the systems and click Next.

4. In communication settings, provide the management controller credentials, verify communication 
settings, and then click Next.

NOTE: You can monitor the deployment in task view. As systems are updated, corresponding 
information in system view and license view are updated.
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Exporting License Archives
You can export an archive of all licenses available in the system. You can use this archive as a backup 
when a system is repaired and the Dell Licensing Portal is not accessible (due to a security restricted 
network.) You can also use the archived licenses for transfer among Dell License Manager installations. 
Dell License Manager retrieves factory-installed licenses during discover and inventory of systems. When 
you archive licenses, a package containing a compressed file of XML license files, similar to the license 
package downloaded from the Dell Online Licensing Portal is created.

To export licenses:

1. From Licenses, click Export Archive.

2. Specify the folder location and click Save.

The licenses are archived in the compressed file format (ZIP format.)

Saving Reports
You can save system information into reports in the CSV, XML, or HTML formats.

To save reports:

1. From Systems, click Save Report.

2. Specify the folder location and file name, and in Save as type, select the report format, and then click 
Save.

3. In Report Saved Successfully, click OK.

Removing Licenses From The Inventory
To remove licenses from the License Manager inventory:

1. From Licenses, select the license you want to delete and click Delete.

2. In Confirm License Removal, click Yes.

Removing Licenses From A System
The Remove License option allows you to either remove a specific license or all licenses from a system. 
To remove licenses:

1. Click Systems.

The System Details pane displays the licenses installed on the system.

2. Under Installed Licenses, select the licenses you want to remove.

3. Click Remove License.

The Remove License window is displayed.
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4. Provide the management controller credentials, confirm the communication settings, and then click 
Finish.
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6
Managing Tasks and Logs
From the Tasks view, you can monitor the progress of long-running tasks. The Task Status table includes 
a summary of executing and recently completed tasks. The Results tab includes a summary of operation 
results and the Execution Logs tab includes the detailed log of the currently selected task or operation.
 

Cancelling Tasks
Cancelled tasks do not terminate until the operations that are already in-progress are concluded. As such, 
it may take several minutes for a cancelled task to terminate. In some circumstances, tasks may complete 
before cancellation can take effect.

To cancel tasks:

1. From Tasks, select the task that you want to cancel and click Cancel Selected Task.

2. In Cancel Task, click Yes.

Log Entries

If a task result is selected, the Execution Log tab includes detailed information about the selected task 
log. If a task result is selected, the log is filtered to entries related to that specific result. Log entries 
consist of the date and time of the entry, a log code, and a detailed log message.

Clearing Completed Tasks
If the Dell License Manager application is closed while tasks are running, then those tasks are terminated. 
You cannot clear tasks that are in progress.

To clear completed tasks:

1. From Tasks, click Clear Completed Tasks.

2. In Clear Completed Tasks, click Yes.

Viewing Dell License Manager Logs
The saved result is available in the Log view. The Result Logs table includes a summary of Dell License 
Manager activity including discovery and inventory, license import, and license deployment or removal 
operations. The Log Entries pane shows detailed results of the currently selected activity. Dell License 
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Manager logs summary based information. The logged information includes status, date and time, unique 
identifier, and a list of logged events.

To view logs, click Logs.

Generating Support Log Archives
When directed by technical support, click Generate Support Log Archive. Select the folder where you 
want to save the archive, and then click Save. This option generates a zip archive containing the text of 
each result log. You can provide the log to technical support as directed.
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7
Troubleshooting

License Importing

Cannot Import Trial Licenses 

Message: Trial licenses are not supported by the license manager.

Resolution: Apply a trial license through the iDRAC or CMC GUI or RACADM CLI. For more information, 
see the iDRAC or CMC documentation.

License Or Archive Is Corrupt Or Unreadable 

Messages:

• Unable to read archive file.
• The archive does not contain any license files.
• Unable to parse license.
• The digital signature is invalid.

Resolution: Download license archive again from the Dell Online Licensing Portal at dell.com/support/
retail/lkm.

License Inventory/Discovery And License Deployment
When resolving discovery/inventory errors, verify that the remote address corresponds to an iDRAC7 or 
greater, by accessing the iDRAC or CMC GUI. To access the iDRAC or CMC GUI, connect to the system 
IP/hostname using a web browser. If the system does not contain iDRAC7, then ignore the error 
message.

Invalid Credentials

Message: Unable to establish communications - Access is denied.
Resolution: Enter correct credentials. If iDRACs do not share common credentials, you must run multiple 
discovery/inventory tasks using different credentials.

Certificate Error 

Messages:

• Unable to establish communications - The SSL certificate contains a common 
name (CN) that does not match the hostname. 
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• Unable to establish communications - The SSL certificate is signed by an 
unknown certificate authority. 

• Unable to establish communications - The SSL certificate could not be checked 
for revocation. The server used to check for revocation might be unreachable. 

• Unable to establish communications - The SSL certificate is expired. 
Resolution: If the certificate name does not match the hostname, install a certificate matching the 
address on which the management controller is inventoried. Alternatively, disable certificate name 
validation in your discovery/inventory settings. For more information, see Communication Settings.

If the certificate authority is not recognized, add the certificate authority to the list of Windows Trusted 
Root Certification Authorities on the management console. Alternatively, disable certificate authority 
validation in the discovery/inventory settings. For more information, see Communication Settings.

If you cannot check the certificate for revocation, make sure that the certificate revocation list server is 
available to the management console. Alternatively, disable certificate revocation list checking in the 
discovery/inventory settings. For more information, see Communication Settings.

If the certificate has expired, generate and install a new certificate. Dell License Manager cannot connect 
to iDRACs using an expired certificate.

Unable To Connect

Messages:

• Unable to ping system - Timed Out 
• Unable to establish communications - Connection to host timed out
Resolution: Verify that the management controller is connected to the network and assigned the 
specified address. Verify that the firewall settings allow you to access the system from the management 
console.

From the iDRAC or CMC GUI, verify that the address corresponds to a system that contains iDRAC7 or a 
later version. To access the GUI, connect to the system IP/hostname from a web browser. If the system 
does not contain iDRAC7, then ignore the error message.

License Status Warnings

Individual Bound License Deployed To Multiple Systems 

Message: One or more licenses with the same Entitlement ID are bound to other service tags and are 
currently deployed.

Resolution: Install each individual bound license, distinguished by a unique Entitlement ID, on a single 
system specified by its service tag. By using the Dell Online Licensing Portal at dell.com/support/retail/
lkm, determine that a license is properly associated with the system. Remove license instances deployed 
to systems other than those specified in the portal.

You may determine to which systems an Entitlement is deployed by sorting or filtering the Entitlement ID 
column within the System Inventory table. Improperly deployed licenses can be removed using the 
management controller GUI. If multiple perpetual licenses are installed on the same system their 
Entitlement IDs are not displayed in the table. You must inspect such systems individually and review the 
installed licenses listed in the System Details pane.
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Original License Missing During Upgrade

Message: The license is designated as an upgrade, however the original license is not currently installed.

Resolution: Make sure that the original license is not reassigned to another system. If the original license 
is not present due to service performed on the system, then, ignore this message.

Unable to View the Help Content in Internet Explorer
Message: The Dell License Manager help content cannot be viewed in some versions of Microsoft 
Internet Explorer.

Resolution: Enable active scripting under security settings and then retry the operation.

1. In Internet Explorer, click Tools → Internet Options.

The Internet Options window is displayed.

2. Click the Security tab, and then click Custom level.

The Security Settings window is displayed.

3. In the Settings pane, scroll down until you find Scripting and Active Scripting.

4. Click Enable, and then click OK.

The Security Settings window is closed.

5. In the Internet Options window, click OK.
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8
Systems — Reference
From Systems, you can discovery and inventory systems, deploy licenses, and save reports.

Field Description

Run Discovery and Inventory Select to discover and inventory the supported 
management controllers.

Deploy Associated Licenses Select to deploy licenses.

Save Report Select to save license reports.

Delete Select to remove systems from the License 
Manager inventory.

 

System Inventory Table
The system inventory table contains a summary of licensable systems. You can sort or resize each 
column. Select a system to view additional information or perform tasks on that system. You can also 
select multiple systems deployment tasks or removal.

Field Description

Selected Click check box to select the system.

System Name The host name of the installed operating system, if available.

Management 
Controller

The host name of the management controller. Clicking the link opens the 
management controller GUI using Microsoft Internet Explorer. The discovery address is 
shown in parenthesis.

System Model The system model name.

Upgrade 
Available

If a license upgrade is available for deployment, a message is displayed.

Service Tag The factory-assigned system Service Tag that uniquely identifies each system. Each 
license is bound to a particular service tag indicating the system on which it is 
deployed.

Evaluation 
Installed 

If applicable, the status of installed evaluation licenses are shown.

Current 
License

The level of functionality currently supported by the management controller. 
Supported levels include:

• Enterprise
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Field Description

• Express

• Express for Blades

• Basic Management

For more information on the management controller functionality supported by each 
feature level, access the online licensing portal at dell.com/support/retail/lkm.

NOTE: Not all hardware supports all management features. For more information, 
see the hardware documentation.

Purchased 
License 

The highest license class of any perpetual license bound to the system is shown. Both 
installed licenses and licenses in inventory awaiting deployment are included when 
calculating the purchased license class.

Entitlement ID The unique license identifier.

Additional 
Information 

If a potential EULA violation is detected, it is indicated in this column.

Last Inventory The date and time the system was last inventoried. The systems will automatically re-
inventory when a license operation is conducted on the system.

Modular 
System

Name of the modular system (chassis) in which the server or sled is installed.

Node ID The unique identifier of the server or sled installed in a modular system (chassis). 
Typically, the Service Tag of a server or the server node identifier of a sled.

Slot The slot occupied by the server or sled in the modular system (chassis).

Systems Detail Pane
The system details pane shows information on a licensable system, including the installed licenses and 
licensable components of that system. The system details contains component details and license details.

Field Description

System Name The host name of the installed operating system, if available.

Management 
Controller

The host name of the management controller.

Model The system model.

Service Tag The service tag of the system.

Discovery 
Address

The IP address or hostname at which the management controller was discovered.

Purchased 
License

The highest license class of any perpetual license bound to the system is shown. Both 
installed licenses and licenses in inventory awaiting deployment are included when 
calculating the purchased license class.
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Field Description

Current 
License

The current license on the system.

Installed 
Licenses

The list of licenses that are installed on the system.

Remove 
License

Select a license in the Installed License grid, and click Remove license to remove a 
license installed on the system.

Selected Click check box to select the license.

Status The license status:

• Green — The license is ok.

• Yellow — The license has a potential problem.

• Red — The license is not functional.

Description The license description.

Entitlement ID The unique license identifier.

Expiration Date on which the license expires (if applicable).

Term The license term. For more information, see Understanding Licenses.

Date 
Purchased

The date the license was purchased.

Date Imported The date the license was imported.

Discovery/Inventory Wizard

Provide these values to set IP range and host information.

Field Description

Add Range or 
IP

Click to open the Edit Inventory Range window for adding a new discovery range.

Edit Select an existing range and click to open the Edit Inventory Range window.

Remove 
Selected

Click to remove the selected range.

Inventory Click the check box to select the IP address.

Range / 
Address Name 

Enter a unique name describing the range.

Start / 
Individual 
Address 

Enter the beginning range of the IPv4 address or the individual IP address.

End Address Enter the ending range of the IPv4 address.
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Field Description

Subnet Mask 
(Optional)

Use subnet mask to exclude network and broadcast addresses from inventory 
attempts. If omitted, each address is treated as a host.

Description 
(Optional)

Enter a description. Each inventory range can include at most a Class B network 
(65,536 addresses).

Edit Inventory Range

Field Description

IP Range or Address Name Enter a unique name describing the range.

Enter an IP Range, an Individual Address, or a List of Addresses

IPV4 Range Select to provide an IPv4 address range.

Start Address Enter the beginning range of the IPv4 address or 
the individual IP address.

End Address Enter the ending range of the IPv4 address or the 
individual IP address.

Subnet Mask Enter the subnet mask for the provided IPv4 
address.

Individual IP Address (IPv4, IPv6, or hostname) Select to provide an individual IP address.

Text file with IP addresses Select to create an inventory range using a text file 
that includes an IP address or host name in each 
line.

Load Click to browse and select the text file.

Description (Optional) Enter a description.

Communication Settings
Optimal parameter values depend on the characteristics of a network. In communication settings, you 
can provide credentials, Ping (ICMP) Settings, and WS-Man Settings.

Field Description

Credentials You must specify the credentials to conduct discovery inventory. Credential 
information is not persistent across task executions.

Management 
Controller Username 

Provide the management controller user name. If using Active Directory 
authentication, enter username in the format Domain\User name.

NOTE: The management controller login privilege is required to perform 
system inventory.
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Field Description

Management 
Controller Password 

Provide management controller password.

Ping Settings (ICMP) 

Require successful 
ping before 
attempting inventory

When enabled, a ping response is received from an address before attempting 
WS-Man inventory communications. This can improve the performance of the 
inventory process. However, disable this option if the network blocks ping 
requests. This option is enabled by default.

Retries The number of times to re-attempt a ping before excluding the system from 
inventory. The default is 3 retries (4 total attempts).

Timeout The time within which a ping response is received before the ping attempt fails. 
The default is 5 seconds.

WS-Man Settings Dell License Manager uses the management controller WS-Man interface to 
obtain inventory information.

Validate Certificate 
Name 

If enabled, this ensures that inventory communications are conducted only 
with systems identifying themselves based on a certificate that matches the 
address used to communicate with that system. If the iDRAC certificate does 
not match the discovery address, then disable certificate name validation for 
Dell License Manager to communicate with the iDRAC. However, if the 
certificate name is not validated, Dell License Manager cannot authenticate the 
identity of the remote system.

Validate Certificate 
Authority 

If enabled, this ensures that the inventory communications are conducted only 
with systems identifying themselves based on a certificate issued by a trusted 
source. If the iDRAC certificate is not issued by a trusted authority, then disable 
validation for Dell License Manager to communicate with the iDRAC. However, 
if the certificate authority is not validated, Dell License Manager cannot 
authenticate the identity of the remote system.

For validation, include a trusted certificate authority as part of the Trusted Root 
Certification Authorities list in Microsoft Windows. For more information, see 
the Microsoft Windows documentation.

Validate Certificate 
Revocation List 

If enabled, this ensures that communications are not conducted with a system 
identifying itself using a certificate that is revoked. If the management console 
cannot communicate with a certificate revocation list server, then disable this 
option for communicating with iDRAC. However, if the certificate revocation 
list is not validated, Dell License Manager cannot authenticate the identity of 
the remote system.

Retries The number of communication retry attempts made, if temporary WS-Man 
communication errors occur before the inventory attempt fails. The default is 1 
retry (2 total attempts).

Timeout The time within which the WS-Man host must begin to return data before the 
communication attempt fails. The default is 30 seconds.
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Field Description

Port The HTTPS communication port configured on the iDRACs. The default port is 
443. On this port, ensure that firewall settings allow HTTPS communication 
between the management station and the iDRACs.
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9
Licenses — Reference
From Licenses, you can import and deploy matching licenses, archive exported license, and save reports.

Field Description

Import Licenses Click to import licenses from a file system.

Export Archive Select to archive licenses.

Deploy Licenses Select to deploy licenses matched to a licensable system. The options include:

• Deploy Selected Licenses

• Automatically Deploy Licenses

Save Report Select to save the license report.

Delete Select to remove licenses from License Manager local database.

Selected Click to select a license.

Description Details of the type of license; Enterprise License, bound, unbound, or upgraded.

Term The license term. For more information, see Understanding Licenses.

Bound Service 
Tag 

The Service Tag to which the license is bound. You can only deploy this license on 
the system with the specified tag.

Deployed The deployment status:

• Yes — The license is deployed.

• No — The license is not deployed.

• Unknown — The corresponding system is not in inventory.

Matching System The system to which you can assign this license.

• Yes — Indicates the associated system is in inventory.

• No — Indicates the system is not in inventory.

Origin The method in which the license was added:

• Imported — The license was imported into Dell License Manager.

• Retrieved — The license was obtained during inventory.

Date Purchased The date the license was purchased.

Date Imported The date the license was imported.

License The license identification number and the details of the license.

Entitlement ID The unique license identifier.
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Field Description

Upgrade ID In the case of an upgrade license, the ID of the license to which the upgrade 
applies.

Expiration Date on which the license expires (if applicable).

License Features The features supported by the selected license.

 

Manage Licenses

Field Description

Selected Click to select license.

Operation 
Status

Details on whether the license is available for deployment.

Entitlement ID The ID of the license.

License 
Description 

The description of the license.

System The name of the system on which to deploy the license. If available, the host name is 
used, otherwise the iDRAC name is used.

Service Tag The factory-assigned system Service Tag, which uniquely identifies each system. 
Each license is bound to a particular Service Tag indicating the system on which the 
license is deployed.

NOTE: Licenses already deployed on a system do not appear in the Operation 
Selection page.

Active License The class and term of the highest class license installed on the system.

Credentials 

Management 
Controller 
Username 

Provide the management controller user name. If you are using Active Directory 
authentication, enter the user name in the format Domain\User name.

NOTE: The management controller login privilege is required to perform system 
inventory.

Management 
Controller 
Password

Provide the management controller password.

WS-Man 
Settings 

Dell License Manager uses the management controller WS-Man interface to obtain 
inventory information.

Validate 
Certificate 
Name 

If enabled, this ensures that inventory communications are conducted only with 
systems identifying themselves based on a certificate that matches the address used 
to communicate with that system. If the iDRAC certificate does not match the 
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Field Description

discovery address, then disable certificate name validation for Dell License Manager 
to communicate with iDRAC. However, if the certificate name is not validated, Dell 
License Manager cannot authenticate the identity of the remote system.

Validate 
Certificate 
Authority 

If enabled, this ensures that inventory communications are conducted only with 
systems identifying themselves based on a certificate issued by a trusted source. If 
the iDRAC certificate is not issued by a trusted authority, then disable validation for 
Dell License Manager to communicate with the management controller. However, if 
the certificate authority is not validated, Dell License Manager cannot authenticate 
the identity of the remote system.

For validation, include a trusted certificate authority as part of the Trusted Root 
Certification Authorities list in Microsoft Windows. For more information, see the 
Microsoft Windows documentation.

Validate 
Certificate 
Revocation List

If enabled, this ensures that communications are not conducted with a system 
identifying itself using a certificate that is revoked. If the management console 
cannot communicate with a certificate revocation list server, then disable this option 
to communicate with iDRAC. However, if the certificate revocation list is not 
validated, Dell License Manager cannot authenticate the identity of the remote 
system.

Retries The number of communication retry attempts made if temporary WS-Man 
communication errors occur before the inventory attempt fails. The default is 1 retry 
(2 total attempts).

Timeout The time within which the WS-Man host must begin to return data before the 
communication attempt fails. The default is 30 seconds.

Port The HTTPS communication port configured on the iDRACs. The default port is 443. 
On this port, ensure that the firewall settings allow HTTPS communication between 
the management station and iDRACs. To save changes and proceed with discovery/
inventory, click Next.

Task Settings

Show task pane 
after launch 

Select to view the task progress in Tasks.
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10
Tasks — Reference
From Tasks, you can view discovery and inventory, and license deployment task information.

Field Description

Cancel 
Selected 
Task 

Select to cancel a listed task.

Clear 
Completed 
Task

Select to purge completed task information.

Status Status type of the task is listed.

• Normal—The task is successfully completed.

• Failure—The task is not completed.

ID Unique ID assigned to the task.

Task Description of the task.

Summary Description of the task’s status.

Progress Indicator of the task’s progress.

Start Time Starting time of the task.

End Time Ending time of the task.

Task 
Results 

Provides status, operation, and result information. It includes the following tabs:

• Results

• Execution Log

Status • Green—The task is successfully completed.

• Yellow—The task is completed with warnings.

• Red—The task is completed with errors.

Operation The description of the operation

Result The summary of the operation result.

NOTE: When generating results for a discovery/inventory IP range, result entries are 
not created for addresses where communication is not established or where a non-
licensable system is detected. For result information on such systems, consult the 
execution log tab.

Execution 
Log 

The Execution Log tab provides detailed information from the selected task log.
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11
Logs — Reference
From Logs, you can view License Manager activities, clear log results, and save reports.

Field Description

Clear Logs Select to purge logged information.

Generate Support 
Log Archive

Select to archive logged information.

Save Report Select to save log report.

Result Status type of the listed task:

• Normal—The task is successfully completed.

• Failure—The task is not completed.

ID Unique ID assigned to the task.

Summary Summary description of the logged event.

Date Date and time at which the task completed.

Log Entries Details of the logged information.
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